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Preface 

 

This User Guide is been implemented by Boot & Work, S.L. working 

under the name Industrial Shields.  

 

Purpose of the manual 

The information contained in this manual can be used as a reference to operating, to 
functions, and to the technical data of the signal modules, power supply modules and 
interface modules.  

 

 

Intended Audience 

This User Guide is intended for the following audience: 

 Persons in charge of introducing automation devices. 

 Persons who design automation systems. 

 Persons who install or connect automation devices. 

 Persons who manage working automation installation. 

 

 

 

 

 

  Warnings: 

 Unused pins should not be connected. Ignoring the directive may damage the 

controller. 

 Improper use of this product may severely damage the controller. 

 Refer to the controller’s User Guide regarding wiring considerations. 

 Before using this product, it is the responsibility of the user to read the product’s User 

Guide and all accompanying documentation. 
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Application Considerations and Warranty 

Read and Understand this Manual 

Please read and understand this manual before using the product. Please consult your 

comments or questions to Industrial Shields before using the product. 

 

Application Consideration                               

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. 

THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR 

PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE 

NOT RATED OR DESSIGNED FOR SUCH PURPOSES.  

Please know and observe all prohibitions of use applicable to the products.  

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY 

WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED 

TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.  

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE 

PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE 

OVERALL EQUIPMENT OR SYSTEM.  

Industrial Shields shall not be responsible for conformity with any codes, regulations or 

standards that apply to the combination of products in the customer’s application or use 

of the product. 

The following are some examples of applications for which particular attention must be  

given. This is not intended to be an exhaustive list of all possible uses of the products, 

nor is it intended to imply that the uses may be suitable for the products: 

 Systems, machines, and equipment that could present a risk to life or property. 

 Nuclear energy control systems, combustion systems, railroad systems, 

aviation systems, medical equipment, amusement machines, vehicles, safety 

equipment, and installation subject to separate industry or government 

regulations. 

 Outdoor use, uses involving potential chemical contamination or electrical 

interference, or conditions or uses not described in this document. 

 

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party 

certification documents identifying ratings and limitations of use that apply to the 

products. This information by itself is not sufficient for a complete determination of the 

suitability of the products in combination with the system, machine, end product, or 

other application or use. 
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Disclaimers             

Weights and Dimensions 

Dimensions and weights are nominal and they are not used for manufacturing 

purposes, even when tolerances are shown. 

 

Performance Data 

The performance data given in this manual is provided as a guide for the user in 

determining suitability and does not constitute a warranty. It may represent the result of 

INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual 

application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS 

Warranty and Limitations of Liability. 

 

Change in Specifications 

Product specifications and accessories may be changed at any time based on 

improvements and other reasons. 

It is our practice to change model numbers when features are changed, or published 

ratings or when significant construction changes are made. However, some 

specifications of the products may be changed without any notice. When in doubt, 

special numbers may be assigned to fix or stablish key specifications for your 

application on your request. Please consult with your INDUSTRIAL SHIELDS 

representative at any time to confirm actual specifications of purchased products. 

 

Errors and Omissions 

The information in this document has been carefully checked and is believed to be 

accurate; however, no responsibility is assumed for clerical, typographical, or 

proofreading errors, or omissions. 
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Warranty and Limitations of Liability 

Warranty 

Industrial Shields’s exclusive warranty is that the products are free from defects in 

materials and workmanship for a period of one year (or other period if specified) from 

date of sale by Industrial Shields. 

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, 

EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-

INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS. 

ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE 

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE 

REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS 

ALL OTHER WARRANTIES, EXPRESS OR IMPLIED 

 

Limitations of Liability 

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, 

OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN 

ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS 

BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY. 

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY, 

REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL 

SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY 

HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO 

CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR 

REPAIR. 
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 General Description M-DUINO FAMILY product 

 

1.1 Zone - Nomenclature 

The nomenclature shown in this point will be used in the whole User Guide, so it is 

important to understand this nomenclature. 

The nomenclature to differentiate the zones is based on the Alphabet, being A the 

shield from below and D the shield from above. Having a B and a C in the middle of 

them. It can have a minimum of 2 zones (A, B) and a maximum of 4 (A, B, C, D). The 

nomenclature is represented on the picture below: 

  

 

 

 

 

 

 

 The inputs in the zone B are named I0.X, being X any number suitable in the 
Shield. Outputs are named as Q0.X and relays as R0.X 

 The inputs in the zone C are named I1.X, being X any number suitable in the 
Shield. Outputs are named as Q1.X and relays as R1.X 

 The inputs in the zone D are named I2.X, being X any number suitable in the 
Shield. Outputs are named as Q2.X and relays as R2.X 

 

1.2 Zone Distribution 

A zone is completely common for every single M-Duino Family PLC. The rest of zones 

can have two different shields. The two shields that can be in every Zone (except for A 

Zone) are the Analog Shield or the Relay Shield. Only 1 Shield is allowed per Zone.  

Depending on the combination that is made to build the PLC it can provide more 

Analog Inputs/Outputs or Relays Outputs. All the zones (B, C, D) can be one of the two 

Shields: 
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The distribution of the different features that provide the M-Duino Family is the 

following one: 

 

 

 

 

Shield B Zone C Zone D Zone 

 
 
 
 
 

Analog Shield 

13 Inputs 
 (13 Digital inputs, 

6 of which can 
work as Analog 

Input)  
 
 

8 Outputs  
(8 Digital Outputs, 

3 of which can 
work as Analog 

Output) 

13 Inputs 
 (13 Digital inputs, 

6 of which can 
work as Analog 

Input)  
 
 

8 Outputs 
(8 Digital Outputs, 

3 of which can 
work as Analog 

Output) 

11 Inputs 
 (11 Digital Inputs, 

4 of which can 
work as Analog 

Input) 
 
 

6 Outputs  
(6 Digital Outputs, 

2 of which can 
work as Analog 

Outputs 

 
 
 
 
 

Relay Shield 

6 Inputs  
(6 Digital Inputs,  
4 of which can 
work as Analog 

Input)  
 

11 Outputs 
(8 Relay Outputs, 
 3 Digital Outputs,  

3 of which can 
work as Analog 

Output) 
 

6 Inputs  
(6 Digital Inputs,  
4 of which can 
work as Analog 

Input)  
 

11 Outputs 
(8 Relay Outputs, 
 3 Digital Outputs,  

3 of which can 
work as Analog 

Output)  
 

6 Inputs  
(6 Digital Inputs,  
4 of which can 
work as Analog 

Input)  
 

9 Outputs 
(7 Relay Outputs, 
 2 Digital Outputs,  

2 of which can 
work as Analog 

Output)  
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1.3 A Zone Features 

Shield A Zone 

 
 
 
 
 

Communication 
Shield 

(1x) Ethernet 
(1x) USB 
(1x) I2C 
(3x) TTL 
(1x) RS-232 
(1x) HALF/FULL Duplex RS-485 
(1x) SPI external Port 
(1x) RTC 
(1x) uSD Socket 
 

 

This is the list of our products depending on the combination of the shields. As it is 

already said above the A Zone is totally common for all the M-Duino Family. 

 

 

 

 

 

 

 

 

 

The nomenclature of the M-Duino Family products consists on placing the name of the 

Shield/s after the total number of I/Os of the product. 

For example M-Duino53ARR+ is a PLC with the 3 extra Zones (B, C, D), which are 

Analog, Relay, Relay respectively. It has 53 I/Os. 

M-Duino B Zone C Zone D Zone 

M-Duino53ARR+ A R R 

 

* There are 2 different exceptions. M-Duino38R+/M-Duino57R+ should be called with this nomenclature M-

Duino38RR+/M-Duino57RRR+, as everything is Relay it is omitted. Also for the M-duino21+/42+/58+ as 

they are all Analog they are not represented with this nomenclature. With the nomenclature represented in 

the User Guide they would be: M-Duino21A+/M-Duino42AA+/M-Duino58AAA+ 

 

M-Duino B Zone  C Zone D Zone 

 Analog Relay Analog Relay Analog Relay 

M-Duino 19R+  X     
M-Duino 21+ X      

M-Duino 38R+  X  X   
M-Duino 38AR+ X   X   
M-Duino 42+ X  X    

M-Duino 50RRA+  X  X X  
M-Duino 53ARR+ X   X  X 
M-Duino 53ARA+ X   X X  
M-Duino 57AAR+ X  X   X 
M-Duino 57R+  X  X  X 
M-Duino 58+ X  X  X  
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1.4 Mechanical dimension 

 

 

 

M-Duino 1 BLOCK I/Os 

 

 

 

 

M-Duino 2 BLOCKS 

I/Os 

 

 

 

 

M-Duino 3 BLOCKS 

I/Os 
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1.5 General Features 

  

CONECTABLE PLC ARDUINO 24Vcc M-DUINO  

MODEL TYPE B Zone  B+C Zone 
B+C+D 
Zone 

 

Input Voltage 12 to 24Vdc 
Fuse protection (2.5A) 

Polarity protection 
 

I max. 1.5A  

Size 101x119.5x70.1 101x119.5x94.7 101x119.5x119.3  

Clock Speed 16MHz  

Flash Memory 256KB of which 8KB used by bootloader  

SRAM 8KB  

EEPROM 4KB  

Communications 
I2C  –  Ethernet Port – USB – RS485 – RS232 -- SPI 

– (2x) Rx, Tx (Arduino pins) 
Max232-Max485-

W5500 

USB consideration! 
Only meant for uploading or debugging, not 

always connected as a serial in a project! 
Cannot be working in 

a final application 

An/Dig Input 10bit 
(0-10Vcc) 

0 to 10V 
Input Impedance: 39K 

Separated PCB ground 
 

Digital Isolated Input 
(24Vcc) 

7 to 24Vdc 
I min: 2 to 12 mA 
Galvanic Isolation 

 

 

* Interrupt isolated 
Input HS (24Vcc) 

7 to 24Vdc 
I min: 2 to 12 mA 
Galvanic Isolation 

 

 

Analog Output 8bit 
(0-10Vcc) 

0 to 10Vdc  
I max: 20 mA 

Separated PCB ground 
 

 

Digital Isolated 
Output (24Vcc) 

5 to 24Vdc 
I max: 70 mA 

Galvanic Isolation 
Diode Protected for Relay 

 

Imax 24Vdc: 410 mA 

Digital Isolated 
Output Relay 

220V Vac 
I max: 5A 

Galvanic Isolation 
Diode protected for Relay 

 

PWM Isolated Output 
8bit (24Vcc) 

5 to 24Vdc 
I max: 70 mA 

Galvanic Isolation 
Diode Protected for Relay 

 

 

Relay Output 
I max: 5A 

V max: 24VDC / 230VAC 
 

Expandability I2C - 127 elements   -  Serial Port RS232/RS485  

* By using this type of signal can no longer use Digital signal 
(24Vdc)  
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 Technical Specifications: 

2.1 General Specifications: 

Item M-DUINO B ZONE M-DUINO B+C ZONE M-DUINO B+C+D ZONE 

Power supply 
voltage 

DC power supply 12 to 24Vdc 

Operating 
voltage range 

DC power supply 11.4 to 25.4Vdc 

Power 
consumption 

DC power supply 30VAC max. 

External 
power supply 

Power supply 
voltage 

24Vdc 

Power supply 
output capacity 

700Ma 

Insulation resistance 20MΩ min.at 500Vdc between the AC terminals and the protective earth terminal. 

Dielectric strength 
2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all 
the external AC terminals and the protective ground terminal. 

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each. 

Ambient temperature (operating) 0º to 45ºC 

Ambient humidity (operating) 10% to 90% (no condensation) 

Ambient environment (operating) With no corrosive gas 

Ambient temperature (storage) -20º to 60ºC 

Power supply holding time 2ms min. 

Weight 445g max. 542g max. 850g max. 

 
 

2.2 Performance Specification: 

Arduino Board ARDUINO MEGA 2560 

Control method Stored program method 

I/O control method Combination of the cyclic scan and immediate refresh processing methods. 

Programming language 
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a 
programming language. “similar to the C”.  http://arduino.cc/en/Tutorial/HomePage 

Microcontroller ATmega2560 

Flash Memory 256KB of which 8KB are used by the bootloader 

Program capacity (SRAM) 8KB 

EEPROM 4KB 

Clock Speed 16MHz 

Clock Speed 16MHz 

 

http://arduino.cc/en/Tutorial/HomePage
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 Precautions 

Read this manual before attempting to use the M-Duino PLC and follow its descriptions for 

reference during operation. 

3.1 Arduino Board 

All M-Duino family PLCs include Arduino Mega Board as controller.  

3.2 Intended Audience 

This manual is intended for technicians, which must have knowledge on electrical systems. 

3.3 General Precautions 

The user must operate M-Duino according to the performance specifications described in this 

manual. 

Before using M-Duino under different conditions from what has been specified in this manual 

or integrating M-Duino to nuclear control systems, railroad systems, aviation systems, vehicles, 

combustion systems, medical equipment, amusement machines, safety equipment and other 

systems, machines, and equipment that may have a serious influence on lives and property if 

used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and 

performance characteristics of M-Duino are sufficient for the systems, machines, and 

equipment, and be sure to provide the systems, machines, and equipment double safety 

mechanisms. This manual provides information for programming and operating the M-Duino.  

 

 Software interface 

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C 

language. They can also be programmed using directly C but it is much easier working with 

Arduino IDE as it provides lots of libraries that helps in the programming.   

Industrial Shields provides boards for programming the PLCs much easier. Basically it is no 

needed to define the pins and if that pins are inputs or outputs. Everything is set up 

automatically if using the boards. 

In order to install Industrial Shields boards, these are the steps that must be followed. 

Requirements: 

Arduino IDE 1.8.0 or above (better to have always the latest version). 
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Steps: 

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. In Additional Boards Manager URLs write the following: 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json 

3. Press OK to save the changes. 

 

4. Go to: Tools -> Board: … -> Boards Manager 

 

 

 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json
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5. Search for “industrialshields” on the browser. 

 

 

 

 

 

 

 

 

 

 

 

6. Click install (selecting the latest version). 

 

Following these steps you will be able to see now the Industrial Shields Boards: 

 

 

Once it is selected the Ardbox Family or M-Duino family an extra option will appear on Tools: 

There, it can be selected the exact model for every family. 



Ref. IS.MDUINO.XXX 

 

 

 

 

 

 

 

 

 

Also there are some examples of programming in File -> Examples -> M-Duino Family. 

Furthermore there are some extra libraries that can be found in Industrial Shields github. 

https://github.com/IndustrialShields/ 

 

 How to connect PLC Arduino to PC 

 

- Connect USB port from PLC to PC.  

NOTE:  
M-Duino Family uses USB-B cable.  
 
 
 

- Open Arduino IDE interface: 
 

- Select Industrial Shields boards -> M-Duino Family 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://github.com/IndustrialShields/
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- Select the correct M-Duino Board. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- Select correct port. 

 

 

 

 

 

 

 

 

 

 

 

 How to connect PLC to power supply 

- M-Duino Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT 

REVERSAL!  

- Make sure that the live and GND connector of the power supply match the PLC. 

- Make sure that the power supply mains output is not higher than 24Vdc. 
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- Suggested power suppliers

  

 M-duino Family Pinout 

7.1 A Zone connection 

 

 

 

 

 

 

 

 

 

 

 

 

 

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any device. 

Base 
(common unit) 

A Zone 

M
-D

u
in

o
 

C
o

n
n

e
c
to

r 

A
rd

u
in

o
 P

in
 

F
u

n
c
ti
o

n
 

SCL 
SDA 
RX0 
TX0 
RX1 
TX1 
TX 
RX 
Z- 
Y+ 
B- 
A+ 

PIN3 
50 SO 
51 SI 

52 SCK 
Reset 
Vin5 
PIN2 
GND 
GND 

24Vdc 

21 
20 
1 
0 
19 
18 
16 
17 
- 
- 
- 
- 
3 

50 
51 
52 

Reset 
Vin5 

2 
- 
- 

I2C/SS 
I2C/SS 
RX0/SS 
TX0/SS 
RX1/SS 
TX1/SS 

RX2(serial 2) 
TX2(serial 2) 

RS485 
RS485 
RS485 
RS485 

Arduino Pin 
SPI 
SPI 
SPI 
SPI 
5V 

Arduino Pin 
Gnd 
Gnd 

Power Supply 

* Not recommended for industrial applications. The 

Jack connector needs to be removed and use the live 

and GND connectors.   

 
 
 
Configuration Switch* (see section 8 for 
configuring the communications. 
Enabling communications disables some 
I/Os) 
 
 
 
 
Communication Pins 
 
 
 
 
 
 
 
 
Power supply connectors  
(24Vdc – GND) 
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*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using 

serial communication. When uploading code to Arduino Mega set switch to ON.  

 

Base 
(common unit) 

A Zone 

M
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F
u

n
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n
 

AREF 
IOREF2 
IOREF1 

7Vdc 
GND 

3.3Vdc 
GND 
5Vdc 
GND 

AREF 
IOREF2 
IOREF1 

7Vdc 

GND 
3.3Vdc 
GND 
5Vdc 
GND 

Arduino PIN 
Arduino PIN 
Arduino PIN 

- 
GND 

Arduino PIN 
GND 

- 
GND 

Ethernet            Arduino                                               Power 
Connector         Reset button        
                                                            USB programmer                         Autoreset 
          connector   

   



Ref. IS.MDUINO.XXX 

 

7.2 B Zone  

7.2.1 Analog Shield 

 

 

  

 

 

 

 

 

 

   

  

 

 

 

 

 

  

 

 

 

 

 

 

                                                           
1 See section 8 to select suitable switch configuration for enable these connections. 

B Zone 

M
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u
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C
o

n
n
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r 

A
rd

u
in

o
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F
u

n
c
ti
o

n
  

I0.12 
I0.11 
I0.10 
I0.9 
I0.8 
I0.7 

(-)I0.6/INT1 
I0.6/INT11 

(-)I0.5/INT0 
I0.5/INT01 

(-)I0.4 
I0.4 

(-)I0.3 
I0.3 

(-)I0.2 
I0.2 

(-)I0.1 
I0.1 

(-)I0.0 
I0.0 

59 
58 
57 
56 
55 
54 

- 
3 
- 
2 
- 

26 
- 

25 
- 

24 
- 

23 
- 

22 

Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 

GND I0.6 
Interrupt 1 In 

GND I0.5 
Interrupt 0 In 

GND I0.4 
Digital Input 
GND I0.3 

Digital Input 
GND I0.2 

Digital Input 
GND I0.1 

Digital Input 
GND I0.0 

Digital Input 

B Zone 

M
-D

u
in

o
 

C
o

n
n

e
c
to

r 

 
A

rd
u
in

o
 P

in
 

    

F
u

n
c
ti
o

n
  

GND 
A0.71 
A0.61 
A0.51 
Q/Vdc 
COM(-) 
Q0.71 
Q0.61 
Q0.51 
Q0.4 
Q0.3 
Q0.2 
Q0.1 
Q0.0 

GND 
6 
5  
4  
- 
- 
6 
5 
4 

40 
39 
38 

37 
36 

GND 
Analog Out 
Analog Out 
Analog Out 

External Isolated Out Vdc 
External Isolated Out GND 

Digital/PWM Out 
Digital/PWM Out 
Digital/PWM Out 

Digital Out 
Digital Out 
Digital Out 
Digital Out 
Digital Out 

Led indicator I/Os state 

 
 
 
Analog/Digital Inputs 
 
 
 
Interrupt Inputs (isolated) 
 
 
 
 
Digital Inputs (isolated)  
 

 

 
 
 
Configuration Switch*  
(see section 8 to select the correct 
configuration for outputs). 
 
 
 
 
Analog Outputs 
 
Voltage Supply/Reference  for 
Digital/PWM Outputs (isolated) 
 
PWM/Digital Outputs 

Top Zone 
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7.2.2  Relay Shield 

 

 

  

 

 

 

 

 

 

   

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 See section 8 to select suitable switch configuration for enable these connections. 
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R0.8 
R0.7 
R0.6 
R0.5 
R0.4 
A0.21 
A0.11 
A0.01 
GND 
Q0.21 
Q0.11 
Q0.01 

GNDCOM 
24VCOM 

37 
38 
39 
40 
24 
6 
5 
4 

GND 
6 
5 
4 

- 
- 

Relay Out 
Relay Out 
Relay Out 
Relay Out 
Relay Out 
Analog Out 
Analog Out 
Analog Out 

GND  
Digital/PWM Out 
Digital/PWM Out 
Digital/PWM Out 

External Isolated Out Gnd 
External Isolated Out Vdc 

 

B Zone 
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R0.3 
R0.2 
R0.1 
GND 
I0.5 
I0.4 
I0.3 
I0.2 
I0.11 

(-)I0.1 
I0.01 

(-)I0.0 

25 
22 
23  

GND  
57 
56 
55 
54 
3 
- 
2 
- 

Relay Out 
Relay Out 
Relay Out 

GND 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 

Interrupt 1 In 
GND I0.1 

Interrupt 0 In 
GND I0.0 

Top Zone 

Led indicator I/Os state 

 
 
 
 
Relay Outputs 
 
 
 
 
 
 
 
Analog Outputs (Switch 
Configuration) 
 
Digital/PWM Outputs 
(isolated)  
 

 

. 
 
 
Relay Outputs 
 
 
 
 
 
 
 
 
Analog/Digital Inputs 
 
Interrupt Inputs (isolated) 
 
Configuration Switch*  
(see section 8 to select the 
correct configuration for 
outputs). 
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7.3 C Zone 

7.3.1 Analog Shield (C Zone) 

 

 

  

 

 

 

 

 

 

   

  

 

 

 

 

 

  

 

 

 

 

 

 

 

  

 See section 8 to select suitable switch configuration for enable these connections. 
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F
u

n
c
ti
o

n
  

I1.12 
I1.11 
I1.10 
I1.9 
I1.8 
I1.7 

(-)I1.6/INT1 
I1.6/INT11 

(-)I1.5/INT0 
I1.5/INT01 

(-)I1.4 
I1.4 

(-)I1.3 
I1.3 

(-)I1.2 
I1.2 

(-)I1.1 
I1.1 

(-)I1.0 
I1.0 

65 
64 
63 
62 
61 
60 
- 

19 
- 

18 
- 

31 
- 

30 
- 

29 
- 

28 
- 

27 

Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 

GND I1.6 
Interrupt 1 In 

GND I1.5 
Interrupt 0 In 

GND I1.4 
Digital Input 
GND I1.3 

Digital Input 
GND I1.2 

Digital Input 
GND I1.1 

Digital Input 
GND I1.0 

Digital Input 

C Zone 

M
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u
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o
 

C
o

n
n
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r 

 
A
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o
 P
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GND 
A1.71 
A1.61 
A1.51 
Q/Vdc 
COM(-) 
Q1.71 
Q1.61 
Q1.51 
Q1.4 
Q1.3 
Q1.2 
Q1.1 
Q1.0 

GND 
7 
9  
8  
- 

- 
7 
9 
8 

45 
44 
43 
42 
41 

GND 
Analog Out 
Analog Out 
Analog Out 

External Isolated Out Vdc 
External Isolated Out GND 

Digital/PWM Out 
Digital/PWM Out 
Digital/PWM Out 

Digital Out 
Digital Out 
Digital Out 
Digital Out 
Digital Out 

 
 
 
Analog/Digital Inputs 
 
 
 
Interrupt Inputs (isolated) 
 
 
 
Digital Inputs (isolated)  
 

 

 
 
 
Configuration Switch*  
(see section 8 to select the correct 
configuration for outputs). 
 
 
 
 
Analog Outputs 
 
Voltage Supply/Reference for 
Digital/PWM Outputs (isolated) 
 
PWM/Digital Outputs 

Led indicator I/Os state 

Top Zone 
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7.3.2  Relay Shield C Zone 

 

 

  

 

 

 

 

 

 

   

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 See section 8 to select suitable switch configuration for enable these connections. 
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R1.8 
R1.7 
R1.6 
R1.5 
R1.4 
A1.21 
A1.11 
A1.01 
GND 
Q1.21 
Q1.11 
Q1.01 

GNDCOM 
24VCOM 

42 
43 
44 
45 
29 
11 
10 
8 

GND 
11 
10 
8 

- 
- 

Relay Out 
Relay Out 
Relay Out 
Relay Out 
Relay Out 
Analog Out 
Analog Out 
Analog Out 

GND  
Digital/PWM Out 
Digital/PWM Out 
Digital/PWM Out 

External Isolated Out GND 
External Isolated Out Vdc 

 

C Zone 
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R0.3 
R0.2 
R0.1 
GND 
I0.5 
I0.4 
I0.3 
I0.2 
I0.11 

(-)I0.1 
I0.01 

(-)I0.0 
 

30 
27 
28  

GND  
63 
62 
61 
60 
19 
- 

18 
- 

 

Relay Out 
Relay Out 
Relay Out 

GND 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 

Interrupt 1 In 
GND I0.1 

Interrupt 0 In 
GND I0.0 

 

 
 
 
 
Relay Outputs 
 
 
 
 
 
 
 
Analog Output (Switch 
Configuration) 
 
Digital/PWM Outputs 
(isolated)  
 

 

. 
 
 
RELAY Outputs 
 
 
 
 
 
 
 
 
Analog/Digital Inputs 
 
Interrupt Inputs (isolated) 
 
Configuration Switch*  
(see section 8 to select correct 
configuration for outputs). 
 

Top Zone 

Led indicator I/Os state 
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7.4 D Zone 

 

7.4.1 Analog Shield (D Zone) 

 

 

  

 

 

 

 

 

 

   

  

 

 

 

 

 

  

 

 

 

 

 

 

 

 See section 8 to select suitable switch configuration for enable these connections. 

D Zone 
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I2.12 
I2.11 
I2.10 
I2.9 
I2.8 
I2.7 

(-)I2.6/INT1 
I2.6/INT11 

(-)I2.5/INT0 
I2.5/INT01 

(-)I2.4 
I2.4 

(-)I2.3 
I2.3 

(-)I2.2 
I2.2 

(-)I2.1 
I2.1 

(-)I2.0 
I2.0 

NC 
NC 
69 
68 
67 
66 
- 

21 
- 

20 
NC 
NC 

- 
35 
- 

34 
- 

33 
- 

32 

NC 
NC 

Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 

GND I2.6 
Interrupt 1 In 

GND I2.5 
Interrupt 0 In 

NC 
NC 

GND I2.3 
Digital Input 
GND I2.2 

Digital Input 
GND I2.1 

Digital Input 
GND I2.0 

Digital Input 

D Zone 
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GND 
A2.7 
A2.61 
A2.51 
Q/Vdc 

COM(-) 
Q2.7 
Q2.61 
Q2.51 
Q2.4 
Q2.3 
Q2.2 
Q2.1 
Q2.0 

GND 
NC 
13  
12 
- 

- 
NC 
13 
12 
NC 
49 
48 
47 
53 

GND 
- 

Analog Out 
Analog Out 

External Isolated Out Vdc 

External Isolated Out GND 
- 

Digital/PWM Out 
Digital/PWM Out 

- 
Digital Out 
Digital Out 
Digital Out 
Digital Out 

 
 
 
Analog/Digital Inputs 
 
 
 
Interrupt Inputs (isolated) 
 
 
 
 
Digital Inputs (isolated)  
 

 

 
 
 
Configuration Switch*  
(see section 8 to select the  correct 
configuration for outputs). 
 
 
 
 
Analog Outputs 
 
Voltage Supply/Reference for 
Digital/PWM Outputs (isolated) 
 
PWM/Digital Outputs 

Led indicator I/Os state 

Top Zone 
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7.4.2  Relay Shield D Zone 

 

 

  

 

 

 

 

 

 

   

  

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 See section 8 to select suitable switch configuration for enable these connections. 
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R2.8 
R2.7 
R2.6 
R2.5 
R2.4 
A2.2 
A2.11 
A2.01 
GND 
Q2.2 
Q2.11 
Q2.01 

GNDCOM 
24VCOM 

47 
48 
49 
NC 
34 
NC 
13 
12 

GND 
NC 
13 
12 

- 
- 

Relay Out 
Relay Out 
Relay Out 

NC 
Relay Out 

NC 
Analog Out 
Analog Out 

GND  
NC 

Digital/PWM Out 
Digital/PWM Out 

External Isolated Out GND 
External Isolated Out Vdc 
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R2.3 
R2.2 
R2.1 
GND 
I2.5 
I2.4 
I2.3 
I2.2 
I2.11 

(-)I2.1 
I2.01 

(-)I2.0 
 

35 
32 
33  

GND  
69 
68 
67 
66 
21 
- 

20 
- 

 

Relay Out 
Relay Out 
Relay Out 

GND 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 

Interrupt 1 In 
GND I2.1 

Interrupt 0 In 
GND I2.0 

 

 
 
 
 
Relay Outputs 
 
 
 
 
 
 
 
 
Analog Output (Switch 
Configuration) 
 
Digital/PWM Outputs 
(isolated)  
 

 

. 
 
 
Relay Outputs 
 
 
 
 
 
 
 
 
Analog/Digital Inputs 
 
Interrupt Inputs (isolated) 
 
Configuration Switch*  
(see section 8 to select the 
correct configuration for 
outputs). 
 

Top Zone 

Led indicator I/Os state 
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 Switch Configuration 

8.1 A Zone: Communications  

 

 

 

 

 

 

 

 

 

*Although the Serigraphy of the 

Switches will only reference to the 

Analog Shields, if a Relay Shield is 

connected the IX.6 changes for IX.1 

and the IX.5 changes for IX.0. Being   

X a value inside of [0..2].  

 

 

 

 

4. SCL/I2.6: Choosing between SCL or the input I2.6. If this switch is ON, it enables the I2.6    

input and disables the SCL. If this switch is OFF, it enables SCL and disables I2.6. If it is a Relay 

Shield I2.6 is changed for I2.1 

3. SDA/I2.5: Choosing between SDA or the input I2.5. If this switch is ON, it enables the I2.5    

input and disables the SDA. If this switch is OFF, it enables SDA and disables I2.5. If it is a Relay 

Shield I2.5 is changed for I2.0 

2. RX1/I1.6: Choosing between RX1 or the input I1.6. If this switch is ON, it enables the I1.6    

input and disables the RX1. If this switch is OFF, it enables RX1 and disables I1.6. If it is a Relay 

Shield I1.6 is changed for I1.0 

1. TX1/I1.5: Choosing between TX1 or the input I1.5. If this switch is ON, it enables the I1.5    

input and disables the TX1. If this switch is OFF, it enables TX1 and disables I1.5. If it is a Relay 

Shield I1.5 is changed for I1.0 

LEFT ZONE 

Switch Analog Shield Relay Shield 

 ON OFF ON OFF 

D ZONE 

SCL/I2.6 I2.6 SCL I2.1 SCL 

SDA/I2.5 I2.5 SDA I2.0 SDA 

C ZONE 

RX1/I1.6 I1.6 RX1 I1.1 RX1 

TX1/I1.5 I1.5 TX1 I1.0 TX1 

B ZONE 

Pin 3/I0.6 I0.6 Pin 3 I0.1 Pin 3 

Pin 2/I0.5 I0.5 Pin 2 I0.0 Pin 2 

uSD & RS-485 

D53(SD) Q2.0 SD - SD 

FD RS-485 HD HD FD HD FD 



Ref. IS.MDUINO.XXX 

4. Pin 3/I0.6: Choosing between Pin 3 or the input I0.6. If this switch is ON, it enables the I0.6    

input and disables the Pin 3. If this switch is OFF, it enables Pin 3 and disables I0.6. If it is a 

Relay Shield I0.6 is changed for I0.1 

3. Pin 2/I0.5: Choosing between Pin 2 or the input I0.5. If this switch is ON, it enables the I0.5    

input and disables the Pin 2. If this switch is OFF, it enables Pin 2 and disables I0.5. If it is a 

Relay Shield I0.5 is changed for I0.0 

2. D53(SD): If this Switch is OFF, it enables the Chip Select of the microSD socket and disables 

Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the microSD 

can’t be used. 

*If the D Zone is an Analog Shield, Q2.0 is also related with D53. Being D53 in ON Mode the SD card MUST NOT be 

used because it can corrupt the microSD.  

*If the D Zone is a Relay Shield there is no problem and it can be set always to OFF. Q2.0 of the Relay Shield is 

related with D12, so it doesn’t affect in any case to the microSD. The pin53 is not connected at all to any 

input/output, it is only connected to the uSD chip select. 

1. FD RS-485 HD: Choosing between FD or HF. If this switch is ON, it enables the Half Duplex 

(HD) option and disables the FD. If this switch is OFF, it enables Full Duplex (FD) and disables 

HD. 

 

 

 

 

 

 

 

1. RTC SDA: This switch enables the communication to communicate with the RTC using 

I2C. Having this switch in ON mode it actives this communication, whereas if it is in 

OFF mode it disables the I2C to reach the RTC.  

 

2. RTC SCL: This switch enables the communication to communicate with the RTC using 

I2C. Having this switch in ON mode it actives this communication, whereas if it is in 

OFF mode it disables the I2C to reach the RTC.  

 

3. NC: Not connected. This switch is not connected to anything, it doesn’t matter if it is in 

ON mode or OFF mode. 

 

4. NC: Not connected. This switch is not connected to anything, it doesn’t matter if it is in 

ON mode or OFF mode. 

LEFT ZONE 

SWITCH ON OFF 

NC - - 

NC - - 

RTC SCL RTC - 

RTC SDA RTC - 
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8.2 Analog Shield 

 

 

 

 

 

                     

 

 

 

 

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF 

it can only act as an Analog Output.   

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide 

this digital output is represented with QX.X, being X any number of the tables above.  

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide 

this analog output is represented with AX.X, being X any number of the tables above.   

 

8.3 Relay Shield 

 

 

 

 

 

 

 

 

 

B ZONE 

SWITCH ON OFF 

NC - - 

Q0.7 Q0.7 A0.7 

Q0.6 Q0.6 A0.6 

Q0.5 Q0.5 A0.5 

C ZONE 

SWITCH ON OFF 

NC - - 

Q1.7 Q1.7 A1.7 

Q1.6 Q1.6 A1.6 

Q1.5 Q1.5 A1.5 

D ZONE 

SWITCH ON OFF 

NC - - 

Q2.7 - - 

Q2.6 Q2.6 A2.6 

Q2.5 Q2.5 A2.5 

B ZONE 

SWITCH ON OFF 

NC - - 

Q0.2 Q0.2 A0.2 

Q0.1 Q0.1 A0.1 

Q0.0 Q0.0 A0.0 

C ZONE 

SWITCH ON OFF 

NC - - 

Q1.2 Q1.2 A1.2 

Q1.1 Q1.1 A1.1 

Q1.0 Q1.0 A1.0 

D ZONE 

SWITCH ON OFF 

NC - - 

Q2.2 - - 

Q2.1 Q2.1 A2.1 

Q2.0 Q2.0 A2.0 
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For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it 

can only act as an Analog Output. 

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide 

this digital output is represented with QX.X, being X any number of the tables above.  

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide 

this analog output is represented with AX.X, being X any number of the tables above.   

 

 M-Duino Arduino  I/Os 5V pins 

The M-Duino has some of the Mega board pins available.  These pins can be programmed 

according to Arduino features such as I/Os operating at 5V or any additional features present 

in the pins (for example I2C communication in pins SCL and SDA). As this pins are directly 

connected to the Arduino Mega board they are not as well protect as the normal inputs. These 

pins are mainly meant to be used as prototyping. 

The Arduino board available pins are summarized in the table below. In order to access some 

of these pins the configuration switch must be set to OFF position (see section 8) and some 

extra considerations must be taken in consideration when using these pins. 

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V. 

These terminals provide direct access to the Mega board. 

A part from the switch configuration there are some special conditions depending on these 5V. 

Now it is going to be shown the considerations to operate with these pins. 

9.1 I2C pins – SDA/SCL 

The I2C protocol is meant to work in a pull-up configuration. A pull-up configuration means 

that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case 

it reads 5V when nothing is connected. The pull-up configuration is stablished by default in 

these pins. 

 If it is meant to work them as a GPIO at 5V, it has to be considered that they are pull-up 

inputs. 

M-Duino terminal Arduino pin Enable Arduino pin 

SCL 21 Communication switch: OFF 

SDA 20 Communication switch OFF 

RX0 0  

TX0 1  

RX1 19 Communication switch: OFF 

TX1 18 Communication switch: OFF 

MISO 50  

MOSI 51  

SCK 52  

Pin 3 3 Communication switch: OFF 

Pin 2 2 Communication switch: OFF 
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*IMPORTANT: I2.5 & I2.6 are not pull-up inputs although they are referred to the I2C pins 

(switch configuration). There is a “reverse pull-up circuit “that is stablished in order to have the 

same behaviour as the other inputs.  

9.2 Serial 0 – RX0/TX0 

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in 

case that all the 5V pins are already performing a function. This is because they are shared 

with the USB interface. If using these pins, the USB communication cannot be working at the 

same time. When the PLC is not installed, the USB communication is normally required for 

debugging, uploading and intercommunicating with the Ethernet controller. If using both 

interfaces at the same time the Arduino board will get blocked.  

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 

9.3 Serial 1 – RX1/TX1 

These pins are only referred to the inputs I1.5/I1.6. If the switch configuration is in OFF 

position the pins RX1/TX1 will be available. If not using the Serial 1 interface these pins can 

work as digital, either input or output.  

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 

9.4 SPI – MISO/MOSI/SCK 

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the 

Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours 

cannot happen at the same time as the Ethernet would not work. 

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 
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9.5 Pin 2/Pin 3 

These pins are only referred to the inputs I0.5/I0.6. If the switch configuration is in OFF 

position the pins Pin 2/Pin 3 will be available. 

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 

    

 

 A Zone Features: Communications & RTC & uSD 

10.1 RS-232 

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16 

and 17 of the Arduino Mega).  

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not 

matter the configuration of the switches to implement a RS-232 communication. 

Using the boards of Industrial Shields, there is a library that simplifies the RS-232 

implementation. 

  

10.2 RS-485 

For RS485 communication protocol the defined Arduino Mega pins are showed in the chart 

below.  

Function Arduino Pin 

DI 14 

RO 15 

RE 11 

DE 46 

 

For the RS-485 communication protocol there is only one switch that affects in this 

communication. The RS-485 protocol will be always enabled, the only switch that affects is the 

one called “FD rs-485 HD” (See Section 8). This switch makes the choosing between RS-485 

Half Duplex or RS-485 Full Duplex (RS-422). 

Using the boards of Industrial Shields, there is a library that simplifies the RS-485 

implementation. 
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10.3 I2C 

I2C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino Family. The pull-up 

resistor is already implemented in the PCB.  

I2C communication is configured by switches, so the switches must be configured in order to 

enable the I2C communication. 

 

 

 

 

To enable I2C the switches SCL/I2.6(I2.1) & SDA/I2.5(I2.0) must be set to OFF mode. In this 

mode the inputs are totally disabled and the I2C is now enabled. 

Industrial Shields does not provide any library to implement the I2C as it can be used the 

standard library of Arduino called Wire. 

 

 

10.4 SPI 

The M-Duino pins used for the SPI bus are summarized in the table below. For SPI bus MISO, 

MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely, 

each of the connected devices will have a single and dedicated SS pin.  

Function M-Duino connection Mega board pin 

MISO 50 S0 50 

MOSI 51 SI 51 

CLOCK 52 SCK 52 

Reset Reset Reset 

SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin2/Pin3 21/20/1/0/19/18/15/14/2/3 

Check the switch configuration at section 8 to enable SS pins. 

 

 

 

 

Switch Analog Shield Relay Shield 

 ON OFF ON OFF 

D ZONE 

SCL/I2.6 I2.6 SCL I2.1 SCL 

SDA/I2.5 I2.5 SDA I2.0 SDA 
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10.5 TTL 

M-Duino has two TTL ports, RX0/TX0, RX1/TX1. TTL0 is accessed with the function Serial (pins 0 

and 1 of the Arduino Mega). TTL1 is accessed with the function Serial1 (pins 18 and 19 of the 

Arduino Mega).  

In order to use the TTL pins the configuration of the switches have to be the following one: 

 

 

 

 

If the switches RX1/I1.6(I1.1) & TX1/I1.5(I1.0) are in OFF mode, the RX1/TX1 will be enabled. In 

order to use TTL3 these switches must be in OFF mode. 

  

 

10.6 Ethernet 

M-Duino Ethernet port controller is based on w5500 IC, which is the compatible IC compatible 

with Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible 

with the M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS 

Arduino Mega pin 10).  

 

 

10.7 RTC 

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the I2C protocol 

communication, so it is required to have enabled the I2C protocol.  

4 switches have to be configured in order to enable the RTC features: 

 

RTC SCL & RTC SDA must be set to ON mode to 

enable the I2C wires to the RTC. If they are in OFF 

mode, the Arduino won’t communicate with the RTC. 

 

 

Switch Analog Shield Relay Shield 

 ON OFF ON OFF 

C ZONE 

RX1/I1.6 I1.6 RX1 I1.1 RX1 

TX1/I1.5 I1.5 TX1 I1.0 TX1 

LEFT ZONE 

SWITCH ON OFF 

NC - - 

NC - - 

RTC SCL RTC - 

RTC SDA RTC - 
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I2C must be enabled in order to 

communicate with the RTC. See 

section 11 I2C to enable it. 

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation 

called RTC. 

10.8 uSD 

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol 

is always enabled, as there are no switches that configure it. However, there is a switch that 

must be placed to ON mode in order to communicate with the uSD: 

D53(SD): If this Switch is OFF, it enables the Chip Select of the microSD socket and disables 

Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the microSD 

can’t be used. 

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of 

the PLC, it is required to open the plastic found in the frontal part and the socket is located 

under the supply of the Arduino. 

 

 

 

 

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation 

called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to 

select the Chip Select of the uSD chip. 

 

 

 

 

 

 

 

 

 

Switch Analog Shield Relay Shield 

 ON OFF ON OFF 

SCL/I2.6 I2.6 SCL I2.1 SCL 

SDA/I2.5 I2.5 SDA I2.0 SDA 

LEFT ZONE 

Switch Analog Shield Relay Shield 

 ON OFF ON OFF 

uSD  

D53(SD) Q2.0 D53(SD) - D53(SD) 
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 I/O technical details:  

 

Digital Output Waveform: 

 

 

 

 

 

 

 

Digital Out-put Turn-off: 

 

PWM Waveform:  
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Analog Out Turn On: 

 

Analog Out Turn-Off: 

 

Analog /Digital input Turn-on: 

 

 

 

 

 



Ref. IS.MDUINO.XXX 

 

 Typical Connections 
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 Connector details: 

 

The connector inside the PLCs that mounts on the PCB is  MC 0,5/10-G-2,5 THT – 1963502 

from Phoenix contact. MC0,5/10-G-2,5THT  

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix 

contact. FK-MC 0,5/10-ST-2,5 

 

Connection details: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Article reference MC 0,5/10-G-2,5 THT 

Height 8,1mm 

Pitch 2,5mm 

Dimension 22,5mm 

Pin dimensions 0,8x0,8mm 

Pin spacing 2,50mm 

Article reference FK-MC 0,5/10-ST-2,5 

Rigid conduit section min. 0,14 mm² 

Rigid conduit section max. 0,5 mm² 

Flexible conduit section min. 0,14 mm² 

Flexible conduit section max. 0,5 mm² 

Conduit section AWG/kcmil min. 26 

Conduit section AWG/kcmil max. 20 

https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1881406&library=usen&tab=1#General
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 Mechanical Characteristics 

 

- Dimension M-duino Family: 

 

 

 

 

 

 

 

 
 
 

- DIN Rail mounting 
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About Industrial Shields: 
 
Direction: Fàbrica del Pont, 1-11 

Zip/Postal Code: 08272  

City: Sant Fruitós de Bages (Barcelona)  

Country: Spain 

Telephone: (+34) 938 760 191 / (+34) 635 693 611 

Mail: industrialshields@industrialshields.com 

mailto:industrialshields@industrialshields.com

